User's Manual for the CIA Records Search Tool (CREST)

A tool for searching and viewing records released by CIA and NIMA under Executive Order 12958 Section 3.4.

Revision A
30 September 2003
## CHANGE LOG

**TITLE:** CREST User's Manual, Revision New

<table>
<thead>
<tr>
<th>REV</th>
<th>APPROVAL DATE</th>
<th>REV BY</th>
<th>PARAGRAPHS AFFECTED</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>29 Sep 2003</td>
<td>JM</td>
<td>Pages iv, 3-6, 8, 13, 21</td>
<td>RFC-02315 ERB</td>
</tr>
</tbody>
</table>

---

**NOTE:** This page is to be removed from the document designated for use by CREST users.

---

**UNCLASSIFIED**

**NW#:** 2407  
**DocId:** 59157774
NOTICE TO CREST USERS

The Central Intelligence Agency (CIA) Records Search Tool (CREST) is owned and maintained by the CIA. Its purpose is to provide storage of and access to declassified U.S. government records. To ensure optimal system performance and data integrity, CREST automatically collects and stores information on system use. CREST does not record personal information or any information that would identify individual users. Your name will not be recorded; the actions you perform while using the system may be.

The following are representative of the types of information collected and stored by CREST:

- Number of users
- Length of session
- Files viewed
- Files printed
- Search terms used
- Attempts to modify or damage system information
- Attempts to access unauthorized portions of the system.

Some of this information is collected to help make the system more useful or to identify system performance or problem areas. For example, by monitoring the number of users and average session length, the CIA can determine if the number of CREST workstations is adequate to meet user demand.

Other information is collected to determine whether unauthorized activities have been performed or attempted. The CIA monitors CREST visitor traffic to identify unauthorized attempts to change information or otherwise damage the system. Unauthorized attempts to modify any information stored on the system, to defeat or circumvent security measures, or to use the system for other than its intended purposes are prohibited and may result in criminal prosecution. If monitoring reveals evidence of possible criminal activity, such evidence may be provided to law enforcement personnel.

USE OF THE CREST SYSTEM CONSTITUTES EXPRESS CONSENT OF THE USER TO THE AUTOMATIC COLLECTION OF INFORMATION ON AND MONITORING OF ALL ACTIONS PERFORMED ON THE SYSTEM
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>OVERVIEW</td>
<td>1</td>
</tr>
<tr>
<td>CREST CONTENTS</td>
<td>3</td>
</tr>
<tr>
<td>GETTING STARTED</td>
<td>5</td>
</tr>
<tr>
<td>The Crest Main Window</td>
<td>5</td>
</tr>
<tr>
<td>Getting Help With CREST</td>
<td>7</td>
</tr>
<tr>
<td>BROWSING THE DATABASE</td>
<td>9</td>
</tr>
<tr>
<td>Using The Browser</td>
<td>10</td>
</tr>
<tr>
<td>Opening Documents</td>
<td>11</td>
</tr>
<tr>
<td>CONDUCTING SEARCHES</td>
<td>13</td>
</tr>
<tr>
<td>Search Overview</td>
<td>13</td>
</tr>
<tr>
<td>Using Wildcards</td>
<td>14</td>
</tr>
<tr>
<td>Case Sensitivity</td>
<td>14</td>
</tr>
<tr>
<td>Basic Searches</td>
<td>14</td>
</tr>
<tr>
<td>Single Word or Phrase Searches</td>
<td>15</td>
</tr>
<tr>
<td>Multiple Word or Phrase Searches</td>
<td>15</td>
</tr>
<tr>
<td>Proximity Searches</td>
<td>17</td>
</tr>
<tr>
<td>Advanced Searches</td>
<td>18</td>
</tr>
<tr>
<td>Advanced Search Features</td>
<td>18</td>
</tr>
<tr>
<td>Text Searches</td>
<td>19</td>
</tr>
<tr>
<td>Date-range Searches</td>
<td>20</td>
</tr>
<tr>
<td>Date-range and Word Searches</td>
<td>20</td>
</tr>
<tr>
<td>Index Searches</td>
<td>21</td>
</tr>
<tr>
<td>Viewing Search Results</td>
<td>22</td>
</tr>
<tr>
<td>Viewing Hits</td>
<td>23</td>
</tr>
<tr>
<td>Viewing Documents</td>
<td>23</td>
</tr>
<tr>
<td>Viewing Hits in Context</td>
<td>24</td>
</tr>
<tr>
<td>Printing Documents</td>
<td>24</td>
</tr>
<tr>
<td>Printing Hit Lists</td>
<td>24</td>
</tr>
<tr>
<td>Conducting Multiple Searches</td>
<td>25</td>
</tr>
<tr>
<td>APPENDIX A</td>
<td>27</td>
</tr>
</tbody>
</table>

CREST USER'S MANUAL, REVISION A – 30 SEPTEMBER 2003

UNCLASSIFIED

NW#:2407    DocId:59157774
LIST OF FIGURES

Figure 1: CREST Main Window ................................................................. 5
Figure 2: CREST Control Menu ................................................................. 6
Figure 3: On-Line LaserFiche (CREST) User's Manual ............................... 8
Figure 4: CREST Main Window ................................................................. 9
Figure 5: Document Window ................................................................... 11
Figure 6: Basic Search Dialog Box ............................................................ 15
Figure 7: Basic Search Dialog Box - AND, OR, or NOT Search .................... 16
Figure 8: Basic Search Dialog Box - Proximity Search ................................. 17
Figure 9: Advanced Search Dialog Box Used for Text Searches .................... 19
Figure 10: Search Results Window ............................................................ 22
Figure 11: Document Window .................................................................. 23
Figure 12: Hit List Printout Dialog Box ..................................................... 25

LIST OF TABLES

Table: Index Information ........................................................................ 27
OVERVIEW

This document is the user's manual for the Central Intelligence Agency (CIA) Records Search Tool (CREST) system at the National Archives and Records Administration (NARA). CREST is based on a commercial off-the-shelf application called LaserFiche® and is used to search, view, and print declassified records released by the CIA and National Imagery and Mapping Agency (NIMA) under the guidance of Executive Order 12958—Classified National Security Information.

This CREST User’s Manual presents a basic introduction to CREST and the key document search and retrieval capabilities of the application. It highlights what most users need to know to search, retrieve, and print records from the database.

IMPORTANT GUIDANCE: IF YOU HAVE ANY QUESTIONS, PLEASE DO NOT HESITATE TO CONTACT A NARA ARCHIVIST FOR ASSISTANCE IN USING THE WORKSTATION AND APPLICATION.
CREST CONTENTS

The CREST system contains all year’s worth of records released electronically by CIA and NIMA under their 25-year review programs. New releases are generally made once a year at the end of the fiscal year. Data available within the system indicates the year of release.

To facilitate using the system, the records on CREST have been sub-divided into six collections of released records as described below:

- Consolidated Translations
- General CIA Records
- Ground Photo Caption Cards
- NIMA Records
- Scientific Abstracts
- STAR GATE.

The Consolidated Translations collection contains translated reports of foreign-language technical articles of intelligence interest. The collection is organized by author and each document covers a single subject.

The General CIA Records collection contains records from the CIA’s archives that are 25 years old or older. These records include a wide variety of finished intelligence reports, field information reports, high-level Agency policy papers and memoranda, and other documents produced by the CIA.

The Ground Photo Caption Cards collection holds cards used to identify photographs in the NIMA ground photograph collection. Each caption card contains a serial number that corresponds to the identical serial number on a ground photograph. The master negatives of the ground photography collection have been accessioned separately to NARA. The caption cards provide descriptive information to help identify which master negatives you may wish to request. This set of records can be used in conjunction with the MS Access database called “CIA Electronic Ground Photography Search Tool” available at NARA.

The NIMA Records collection contains records from NIMA’s archives that are 25 years old or older. These records are primarily photographic intelligence reports.

The Scientific Abstracts collection contains abstracts of foreign scientific and technical journal articles from around the world. This collection represents a significant effort by
UNCLASSIFIED

the Agency to document scientific research in the Soviet Union and Eastern Bloc countries.

The STAR GATE collection contains records from a 25-year Intelligence Community effort that used remote viewers who claimed to use clairvoyance, precognition, or telepathy to acquire and describe information about targets that were blocked from ordinary perception. The records include documentation of remote viewing sessions, training, internal memoranda, foreign assessments, and program reviews.
GETTING STARTED

The Crest Main Window

The CREST Main Window (Figure 1) is organized into five major sections:

- Title Bar
- Menu Bar
- Tool Bar
- Folder Browser
- Status Bar.

Figure 1: CREST Main Window
The **Title Bar**, located at the top of the CREST Main Window, displays the name of the open database in square brackets, the Control Menu icon, and the Window Sizing buttons. The Control Menu icon, located on the left side of the Title Bar, accesses the Control menu (Figure 2), which lists options for manipulating the window.

![Figure 2: CREST Control Menu](image)

The Window Sizing buttons, located on the right side of the Title Bar, are shortcuts to some of the options available on the Control menu.

The **Menu Bar**, located immediately below the Title Bar, lists the menus of functions available for use from the CREST Main Window. These are File, View, Retrieve, Tools, Security, Windows, and Help. When selected, each of these menus presents a drop-down list of available options. Note: The Tools and Security menus are for use by CREST system administrators only.

The **Tool Bar**, located below the Menu Bar, contains buttons that can be used to execute commonly accessed functions. These buttons are simply shortcuts to the corresponding menu options available on the Menu Bar. The following buttons are available on the CREST Main Window:

1. **Search** ![Search Icon]: This button initiates the Basic Search function, which is used to conduct simple searches for one or two words or phrases. The function is described in detail in Basic Searches below.
2. **Advanced Search** [ ]: This button initiates the Advanced Search function, which is used to conduct complex searches. This function is described in detail in Advanced Searches below.

3. **Print** [ ]: This button is used to print a document.

4. **Help** [ ]: This button initiates the Help function.

The **Folder Browser**, which is located in the center of the CREST Main Window and occupies most of the window's space, displays the contents of the database. The database is further divided into folders representing each of the collections. Each folder contains groups of related records organized according to CIA provenance of the original records. Selecting (single-clicking) a folder in the left pane of the Folder Browser displays the contents of the folder in the right pane of the Browser. Double-clicking a folder in the left pane displays the contents of the folder in the right pane of the Browser and in the left pane of the Browser, indented underneath the folder. Standard horizontal and vertical window **Scroll Bars** are present when the contents of the pane continue past the viewing area.

The **Status Bar**, located along the bottom of the CREST Main Window, provides messages to the user on the status of the system, along with document counts for search results.

**Getting Help With CREST**

If you have questions about how to use CREST or encounter problems while using it, you have two primary tools outside of this User's Manual:

1. Use CREST's on-line help manual, which can be accessed from the CREST Menu Bar or Tool Bar.
   
   a. Choose the **Help** menu or click the **Help** button. The LaserFiche User's Manual (Figure 3) will appear.
UNCLASSIFIED

Using the Folder Browser:

You can use the folder browser to view and manage the folder hierarchy and the documents in each folder.

![Folder Browser Diagram]

**Figure 3: On-Line LaserFiche (CREST) User’s Manual**

b. Use the help text that is presented or click the **Contents** or **Index** buttons to search for help on other topics.

c. Choose the **Exit** option from the **File** menu to close the LaserFiche User’s Manual.

2. Enlist the assistance of a NARA Archivist. NARA Archivists have been trained in the use of CREST and are available to assist you in using the tool.
BROWSING THE DATABASE

CREST allows you to find records using the CIA job, box, folder, and document numbers. This numbering corresponds to the original CIA provenance of the material as it was retired. The concatenation of job, box, folder, and document numbers creates the Executive Standard Document Number (ESDN), which uniquely identifies each document.

![Crest Main Window](image)

**Figure 4: Crest Main Window**

Key information available on the CREST Main Window includes:

- **Job (e.g., 54-00252A):** The job number is a nine-character job identifier of the group of retired documents to which a box is assigned. It is a reference identifier for a set of retired records. It is the first identifier in the job/box/folder/document hierarchy. The first two characters of the job number indicate the year the records were retired and characters four through nine are sequentially assigned within a year.
Box (e.g., Box 0001): The box identifier is the number assigned to a specific box within a job. It is a sequential number and should be unique within a job.

Folder (e.g., Folder 0001): The folder identifier is a sequential number assigned to each folder within a box. It represents the physical order in which the folders are arranged within the box and should be unique within a box.

The job, box, folder and document numbers are embedded within the ESDN as shown in the example below.

CIA-RDP 54-00252A 0001 0001 0015 -2

The document number is the sequential identifier of the document within the folder.

Using The Browser

As shown in Figure 4, the CREST Main Window opens with a listing of collections within the database. In each collection, you can drill down to identify the jobs in a simple tree directory format. Clicking a job produces a branch listing of boxes in that job. Clicking a box produces a branch listing of folders in the box. Clicking a folder produces a branch listing of documents in the folder. The documents within that folder will appear in the right pane, along with several columns of index information on the documents listed in the folder.

To expand branches in the tree structure in the left pane:

1. Double-click the job identifier to view boxes available within the job.
2. Double-click the box identifier to view folders available within the box.
3. Double-click a folder identifier to view the documents available within the folder. The documents will appear in the right pane of the window.

NOTE: DOUBLE-CLICKING AN OPEN BRANCH IN THE TREE WILL CLOSE THE BRANCH, MAKING VIEWING OF THE HIGHEST LEVEL IN THE TREE EASIER.
Opening Documents

When you have located the document for which you were looking, double-click the desired document title in the right pane to open the Document Window (Figure 5).

![Figure 5: Document Window](image)

The Document Window displays the image of the selected document in the left pane and its OCR text in the right. See Viewing Documents below for more information on using this window.
CONDUCTING SEARCHES

Search Overview

One of the main features of CREST is the capability to search for documents meeting certain criteria. CREST offers a number of ways to search for documents:

- **Word or Phrase Searches:** You can search for documents containing specific words or phrases. For example, you can search for documents that contain the word *Stalin* or the phrase *Soviet Union*. When you use CREST to find documents containing certain words or phrases, the system searches OCR text files. OCR stands for optical character recognition, which is an automated process used to translate the image of a document into searchable text. Every document image in CREST has been put through the OCR process. The accuracy of the OCR text depends on factors such as the age of the scanned document, the type of paper on which the document was printed, and the extent of staining or other marking that obscures text on the document image. Because OCR text may not be completely accurate, word or phrase searches may not find all documents meeting the search criteria. Though word and phrase searches can yield invaluable results, you may want to augment these searches with other types of searches to get the best possible results.

- **Index Searches:** You can search for documents having certain index information. Index information is basic information about a document, such as document title or document date, that has been entered into CREST database fields. This includes two fields that are used to assign each document into a collection and to assign the year that the document was released to the public. Appendix A contains a description of the document index information stored in CREST.

- **Combination Searches:** You can use CREST to locate documents that contain certain words or phrases and have certain index information. For example, you can search for all documents that contain the word *Cuba* and were created in 1961.

Each document meeting your search criteria is called a “hit” and is presented with all other documents meeting the search criteria on a “hit list.” From the hit list, you may open each document to view its image.
Using Wildcards

Because the accuracy of OCR text and index data varies, it is wise to use the shortest possible character set that uniquely identifies your topic of interest. This approach maximizes the number of hits you will receive. To accomplish this goal, you may want to use wildcards in your search strings.

Wildcards are special characters used in place of other characters that may be in the text you are trying to find. CREST offers four wildcards:

- * (Asterisk): The asterisk is used to indicate that zero or more characters may be in the location in which the asterisk is typed. For example, searching on assass* will find documents containing assassin, assassins, or assassination.

- ? (Question Mark): The question mark is used to represent any single character that may be in the location in which the question mark is typed. For example, searching on RDP33-02415A0001000? will find all documents in the first nine folders of the specified job-box combination.

- [ ] (Brackets): The brackets are used to indicate that anyone of a series of specified characters may be located in the spot in which the brackets are typed. For example, searching on [rf]jk will find documents containing only RFK and JFK.

- - (Dash): The dash is used in combination with the brackets to represent a range of characters. For example, CIA-RDP5[0-9]* will find all documents retired in the 1950s.

Case Sensitivity

CREST is not case sensitive. When entering search criteria anywhere in CREST, you may use all lowercase letters, all capital letters, or any combination of lowercase and capital letters. CREST will find all documents meeting your search criteria regardless of case.

Basic Searches

The basic search tool is intended for most searches. The user may search for a single word or phrase, two words or phrases, or words or phrases within a certain number of words of each other.
Single Word or Phrase Searches
To perform a basic search for a single word or phrase:

1. Choose the Search option from the Retrieve menu or click the Search button. The Basic Search dialog box will be displayed.

2. Click the Phrase button.
3. Enter the word or phrase you want to find in the Phrase field.
4. Click the Fuzzy Word Search box if you would like to find words that are spelled similarly to the ones you entered in the Phrase field. Note: Searches that employ the fuzzy-search feature take longer to complete than those that do not use this feature.
5. Click the Search button to execute the search. A list of documents meeting your search criterion will be displayed in a Search Results window. The Search Results window is described in Viewing Search Results below.

Multiple Word or Phrase Searches
To perform a basic search for two words or phrases:

1. Choose the Basic Search option from the Retrieve menu or click the Search button. The Basic Search dialog box will be displayed. (See Figure 6 above.)
2. Click the And, Or, or Not button, depending on the type of search you want to conduct. The Phrase field on the Basic Search dialog box (Figure 7) will be replaced with a Phrase 1 field and a Phrase 2 field.

![Figure 7: Basic Search Dialog Box - AND, OR, OR NOT SEARCH](image)

- **And**: Finds documents that contain both words or phrases entered in the Phrase 1 and Phrase 2 fields (for example, Phrase 1 = stalin And Phrase 2 = hitler finds documents that contain both Stalin and Hitler).
- **Or**: Finds documents that contain at least one of the words or phrases entered in the Phrase 1 and Phrase 2 fields (for example, Phrase 1 = stalin Or Phrase 2 = hitler finds documents that contain either Stalin or Hitler or both Stalin and Hitler).
- **Not**: Finds documents that contain the word or phrase entered in the Phrase 1 field but not the word or phrase entered in the Phrase 2 field (for example, Phrase 1 = korea Not Phrase 2 = north finds documents that contain the word Korea but do not contain the word North).

3. Enter a word or phrase in each of the Phrase fields.

4. Click the Fuzzy Word Search box if you would like to find words that are spelled similarly to the ones you entered in the Phrase field. Note: Searches that employ the fuzzy-search feature will take significantly longer to complete than those that do not use this feature.

5. Click the Search button to execute the search. A list of documents meeting your search criteria will be displayed in a Search Results window. The Search Results window is described in Viewing Search Results below.
### Proximity Searches

A proximity search retrieves documents that contain words or phrases located within a certain number of words from each other. To perform a proximity search:

1. Choose the **Basic Search** option from the **Retrieve** menu or click the **Search** button. The Basic Search dialog box (Figure 8) will be displayed.
2. Click the **Within** button. The Phrase field will be replaced by three fields: Phrase 1, Within, and Phrase 2.

   ![Basic Search Dialog Box - Proximity Search](image)

**Figure 8: Basic Search Dialog Box - Proximity Search**

- **Within**: Finds documents in which the word or phrase entered in the Phrase 2 field is located within a specified number of words of the word or phrase entered in the Phrase 1 field (for example, Phrase 1 = stalin **Within 25 Words of** Phrase 2 = hitler finds documents in which the word Stalin appears within 25 words of the word Hitler).

3. Enter a word or phrase in each of the Phrase fields.
4. In the Within field, enter the maximum number of words that can separate the words or phrases entered in the Phrase 1 and Phrase 2 fields.
5. Click the Fuzzy Word Search box if you would like to find words that are spelled similarly to the ones you entered in the Phrase field. Note: Searches that employ the fuzzy-search feature will take significantly longer to complete than those that do not use this feature.
6. Click the **Search** button to execute the search. A list of documents meeting your search criteria will be displayed in a Search Results window. The Search Results window is described in **Viewing Search Results** below.

**Advanced Searches**

In addition to offering a simple way to conduct basic searches, CREST offers the capability to design complex searches via its Advanced Search function. Advanced searches find documents that contain three or more words or phrases, or documents that contain certain words or phrases and also meet other search criteria. For example, you can search for documents that contain the word Korea and were created within a three-year timeframe.

**Advanced Search Features**

Unlike the Basic Search function, the Advanced Search function allows the use of parentheses and embedded operators to compose searches. Parentheses permit the nesting of search terms within other search terms, which can be nested to any level.

Advanced search operators and their keyboard equivalents are shown below.

- **AND:** & (ampersand)
- **OR:** | (vertical bar)
- **NOT:** - (minus sign)
- **WITHIN:** ^# (caret followed by the number of words that may separate the terms)

For example, if you want to find all documents pertaining to either Khrushchev or Eisenhower and also related to the U-2, you can enter the following search term:

\[(Khrushchev \mid Eisenhower) \& U-2.\] The vertical bar represents OR and the ampersand represents AND.

You can also perform proximity searches by entering a caret (^) followed by the maximum number of words separating the two phrases. For example, if you are interested only in documents in which U-2 is located within 25 words of either Khrushchev or Eisenhower, the query would read:

\[(Khrushchev \mid Eisenhower)^{25} U-2.\]
Text Searches

To conduct an advanced text search:

1. Choose the **Advanced Search** option from the **Retrieve** menu or click the **Advanced Search** button on the CREST main Tool Bar. The Advanced Search dialog box will be displayed.

2. Enter your text search criteria in the Word Search field. Use parentheses and operators as described above to clarify your search.

3. Click the Fuzzy Word Search box if you would like to find words that are spelled similarly to the ones you entered. Note: Searches that employ the fuzzy-search feature will take significantly longer to complete than those that do not use this feature.

4. Click the **Search** button to execute the search. A list of documents meeting your search criteria will be displayed in a Search Results window. The Search Results window is described in **Viewing Search Results** below.

---

**FIGURE 9: ADVANCED SEARCH DIALOG BOX USED FOR TEXT SEARCHES**
**Date-range Searches**

To conduct a search for documents produced within a certain date range:

1. Choose the **Advanced Search** option from the **Retrieve** menu or click the **Advanced Search** button on the CREST main Tool Bar. The Advanced Search dialog box will be displayed (see Figure 9 above).

2. Enter your date search criteria in the **Word Search** field, using the following format:
   
   \{DOCUMENT:[DOCUMENT DATE] >= "mm/dd/yyyy"} \& \{DOCUMENT:[DOCUMENT DATE] <= "mm/dd/yyyy"\}

   For example, \{document: [document date] >= "01/01/1961" \& \{document: [document date] <= "12/31/1961" \} will find all documents produced in 1961.

3. Click the **Search** button to execute the search. A list of documents meeting your search criteria will be displayed in a **Search Results** window. The Search Results window is described in **Viewing Search Results** below.

**Date-range and Word Searches**

To conduct a search for documents produced within a certain date range and containing specific text:

1. Choose the **Advanced Search** option from the **Retrieve** menu or click the **Advanced Search** button on the CREST main Tool Bar. The Advanced Search dialog box will be displayed (see Figure 9 above).

2. Enter your date and word search criteria in the **Word Search** field, using the following format:
   
   \{DOCUMENT:[DOCUMENT DATE] >= "mm/dd/yyyy"\} \& \{DOCUMENT:[DOCUMENT DATE] <= "mm/dd/yyyy"\} \& \text{search word}

   For example, \{document: [document date] >= "01/01/1961" \& \{document: [document date] <= "12/31/1961" \} \& \text{cuba} will find all documents produced in 1961 that also contain the word Cuba.

3. Click the Fuzzy Word Search box if you would like to find words that are spelled similarly to the ones you entered. Note: Searches that employ the fuzzy-search feature will take significantly longer to complete than those that do not use this feature.

4. Click the **Search** button to execute the search. A list of documents meeting your search criteria will be displayed in a **Search Results** window. The Search Results window is described in **Viewing Search Results** below.
Index Searches

To conduct an advanced search of CREST index data:

1. Choose the Advanced Search option from the Retrieve menu or click the Advanced Search button on the CREST main Tool Bar. The Advanced Search dialog box will be displayed.

2. Select the Document template from the Template drop-down list on the upper right side of the screen. (The General template is not used.)

3. Enter search criteria in any of the fields on which you want to search. Use the arrow keys or the TAB key to move from one field to the next.

4. Click the Search button to execute the search. CREST will return documents that meet all the criteria entered. The documents will be displayed in a Search Results window, which is described in Viewing Search Results below.

Note: You can use the Date field only to search for documents produced on a single date. No wildcards or operators can be entered in this field (only numbers). If you would like to search for documents produced during a certain time period, use the date-range formulas described in Date-range Searches and Date-range and Word Searches above.

The values in the Collection field correspond to the six collections defined on pages 3-4. This allows the user to focus a search on only one collection, such as STAR GATE. Also the Year Released field corresponds to the fiscal year in which the records were released to the public. This allows the user to search against just the most currently released records, for example.

See Appendix A for a description of each of the index fields.
UNCLASSIFIED

Viewing Search Results

After executing a search, any documents meeting the search criteria will be presented in a hit list in the Search Results Window Figure 10).

The Search Results Window is divided into two panes. The top pane displays the documents meeting the search criteria. The documents are ranked in descending order from those containing the most hits to those containing the fewest hits. The bottom pane of the window, displays for the selected document in the top pane the actual "hit" (criterion met) along with the number of the page on which the hit is found. (Note: Hits are displayed in the bottom pane of the Search Results Window only for text searches.)
Viewing Hits

To view the hits in a document without opening the document:

1. Select the document of interest in the top pane of the Search Results Window. The hits in that document, along with the context in which the hits are found, will be displayed in the lower pane of the Search Results Window.

2. Use the arrow keys in the lower pane of the window to scroll through the hits for the selected document.

Viewing Documents

To view a document on the hit list:

1. Double-click the document you would like to view in the top pane of the Search Results Window. The first page of the document will be displayed (Figure 11). Hits will be highlighted where they appear in the document.

2. To increase the magnification of the document image, click the **Zoom In** button or choose the View – Scale Image – Enlarge menu option. To decrease the magnification of the document image, click the **Zoom Out** button or
choose the View – Scale Image – Reduce menu option. Double-click the document image to return it to its original scale.

3. To rotate a page image 90 degrees clockwise, click the Rotate button [II] or choose the View – Image – Rotate menu option. This page orientation remains in effect until the image is rotated again; however, it will not affect the orientation of the page if it is printed.

4. To navigate through the document, use the Page Navigation buttons at the bottom of the Document Window.
   a. Click the up arrow [.] to display the previous page of the document.
   b. Click the down arrow [.] to display the following page of the document.
   c. Click the Page X of Y button [Page X of Y] and enter the desired page number to display a specific page of the document.

5. Choose the Close option from the File menu to close the document and return to the hit list.

Viewing Hits in Context
To view the place in the document in which a hit is found:

6. Double-click the hit you would like to view in the bottom pane of the Search Results Window. The document will open to the page on which the hit is located. The selected hit, as well as any other hits on that page, will be highlighted where it appears in the document.

1. Choose the Close option from the File menu to close the document and return to the hit list.

Printing Documents
To print a document:

1. Select one or more documents on the Search Results Window or double-click to open the desired document.

2. Click the Print button [.] on the Tool Bar.

3. Complete the Print dialog box and click OK.

Printing Hit Lists
To print a hit list:
UNCLASSIFIED

1. From the Search Results Window, choose the Print Hit List option from the File menu. The LaserFiche Hit List Printout dialog box will be displayed.

![Figure 12: Hit List Printout Dialog Box]

2. Click Yes if you would like to include information from the lower pane of the Search Results window (see Figure 12). Select No if you would like the printout to include only the list of responsive documents.

Conducting Multiple Searches

It is possible to conduct another search directly from the Search Results Window by selecting the Basic or Advanced Search function. However, it is advisable to close the Search Results Window when you have finished reviewing the documents on the hit list. If too many windows are left open at one time, CREST will stop conducting searches and return the following error message: Search error: Failed to initialize search [6650:7824]

NOTE: You can use standard cut and paste functions to copy search criteria from one search dialog box to another.
APPENDIX A

In addition to a document image and OCR text, each document in CREST has a number of associated index fields that identify and provide descriptive information about the document. The following table describes the index information stored on CREST documents.

Table: Index Information

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOCUMENT TITLE</td>
<td>The unclassified title/subject of the document with classified data removed. If an obvious title does not exist on the original document, this field will state 'UNTITLED.'</td>
</tr>
<tr>
<td>ESDN</td>
<td>The Executive Standard Document Number. A unique alphanumeric string for documents. The format consists of: Agency ID (3 characters) + hyphen + job number + box number + folder number + document number (up to 24 characters) + hyphen + check digit (1 character).</td>
</tr>
<tr>
<td>DOCUMENT DATE</td>
<td>The date the original document was created as indicated on the physical document.</td>
</tr>
<tr>
<td>ORIG CLASS</td>
<td>The classification of a document as indicated on the original document.</td>
</tr>
<tr>
<td>DOCUMENT TYPE</td>
<td>The type of document (e.g., Memo).</td>
</tr>
<tr>
<td>PAGES</td>
<td>The total number of pages in the original document image. (If the original document was double sided, each side will be counted as a page.) This field does not refer to the actual page numbers on the document, but to the total number of pages in the electronic document image.</td>
</tr>
<tr>
<td>COPYRIGHT</td>
<td>A flag used to indicate whether or not a document contains copyright material.</td>
</tr>
<tr>
<td>DECISION</td>
<td>The final review decision applied to a document by the reviewer.</td>
</tr>
<tr>
<td>EXEMPT CODE</td>
<td>A list of all annotation codes applied to a document.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PARENT DOC#</td>
<td>The ESDN of the parent document to which this document is attached.</td>
</tr>
<tr>
<td>FOLDER TITLE</td>
<td>The unclassified title of the folder with classified information removed.</td>
</tr>
<tr>
<td>JOB NUMBER</td>
<td>A reference identifier defined by the Agency for a set of records retired by an Information Management Officer. The first two characters of the job number indicate the year the records were retired and characters four through nine are sequentially assigned within the year.</td>
</tr>
<tr>
<td>BOX NUMBER</td>
<td>The number assigned by the Agency to a specific box within a job.</td>
</tr>
<tr>
<td>FOLDER NUMBER</td>
<td>A sequential number assigned to folders within a box. It represents the physical order in which the folders are arranged within the box.</td>
</tr>
<tr>
<td>DOCUMENT NUMBER</td>
<td>A sequential number assigned to documents within a folder. It represents the physical order in which the documents appear in the folder.</td>
</tr>
<tr>
<td>MEDIA ID</td>
<td>Represents the number of media used to load the document into CREST.</td>
</tr>
<tr>
<td>COLLECTION</td>
<td>Identifier for the collection which corresponds to the name of the primary folder in the browser. Available to allow users to search for records by collection.</td>
</tr>
<tr>
<td>YEAR RELEASED</td>
<td>Identifier for the fiscal year the documents were released. Available to allow users to search records by year.</td>
</tr>
</tbody>
</table>